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Preface
PFRDA extended NPS to the Corporate sector in December, 2011 wherein a Corporate adopts NPS for all its employees under the employer-employee relationship. The Corporate entities adopting NPS were facilitated by the POP appointed by the Corporate for all NPS related services. NPS Trust, in order to facilitate Subscriber Registration and Contribution Upload online by Corporates, has now made available the eNPS platform to the Corporates. This document describes the standard operating procedure to be followed by the Corporates for preparation and upload of contribution file in the CRA system. 

1. Introduction: 
Now the Subscribers associated with any Corporate registered in CRA can join NPS through eNPS portal and contribute through the associated Corporate. Corporates shall prepare the contribution files for the Subscribers and upload the same in the CRA system. Simultaneously, Corporates shall transfer the clear funds to a designated account maintained with Trustee Bank. On the basis of contribution details uploaded by Corporate, CRA will provide fund transfer instructions to the trustee bank as a part of settlement process..
Corporates shall prepare Subscribers’ Contribution File (SCF) for the clear funds and upload it to CRA system. SCF will contain details such as CHO Registration number, Corporate Branch Office (CBO) registration number, PRAN of the Subscriber, amount of the Subscriber contribution, etc. Corporates shall prepare the SCF only for the Subscribers who are registered in the CRA system under the same Corporate.

2. Systems Requirements for Corporate:

Pre-Requisites for accessing the CRA system by Corporate:
1. The Corporate should inform CRA about adoption of subscriber contribution upload alongwith the Digital Signature Certificate details.
2. Valid DSC (Digital Signature Certificates) based User IDs provided by CRA.
3. Minimum IT Infrastructure requirements (as stipulated by PFRDA from time to time) available at Corporate uploading office.
4. Corporate should have the minimum software/hardware requirement to access CRA system.
5. The Corporate shall install FPU (File Preparation Utility) & FVU (File Validation Utility) on a desktop machine whose minimum hardware requirements are as per CRA requirements. The minimum software and hardware requirements are listed below:-
a. Browser -  Internet Explorer 6.0 and above
b. Java Runtime Environment – JRE 1.5
c. Operating System – Windows 2000 Professional/Windows XP
d. Processor – Intel Pentium PV/Celeron (333 MHz or higher CPU)
e. Memory – Minimum 256 MB RAM


3. Procedure for Installing FPU & FVU:

3.1. File Preparation Utility (FPU):

To facilitate the digitisation and consolidation of the pension contribution details of the Subscribers, CRA has developed a utility called File Preparation Utility (FPU). It is a JAVA based utility which can be easily installable on a desktop machine. For ease of use, the utility is based on the MS Excel format. Corporate can freely download the FPU from CRA website www.npscra.nsdl.co.in available at Download/Software download/Utilities. Corporates should ensure that latest version of FPU is being used. Corporate can get the latest updates of FPU version from CRA website. However, it is not mandatory for Corporate to use the FPU provided by CRA. Corporate can alternately use the file formats of FPU and build a utility in their own back office to create the contribution file. In case Corporates wants to use their own back office to prepare the file, they may refer to the file formats for FPU which are available at CRA website www.npscra.nsdl.co.in.

3.2. File Validation Utility (FVU):

FVU is a Java based utility developed by the CRA to ensure that SCF prepared by Corporate is in conformity with the file formats of CRA. Corporates can freely download the FVU from CRA website www.npscra.nsdl.co.in available at Download/Software download/Utilities. Corporates should ensure that latest version of FVU is being used. Corporate can get the latest updates of FVU version from CRA website. FVU can be hosted on any Windows PC. The minimum configurations with respect to installation of FVU are identical to those needed for the FPU. It is mandatory for Corporates to validate the SCF through FVU before uploading the same to CRA.

3.3. Installation of FPU and FVU:

1) Corporate User shall access the CRA website www.npscra.nsdl.co.in. and download the FPU & FVU and save it on the local machine.
[Before downloading the FPU & FVU, it is imperative that the Corporate User shall have to install the latest JAVA version on the machine where the FPU & FVU are to be installed. If this particular version of JAVA is not installed on the machine, then the FPU & FVU will not be operational. Corporates can download the required version of JAVA www.java.com.
 2)   After successfully downloading the FPU & FVU, on navigating to the folder on the local machine, where the FPU & FVU are saved, ‘.JAR‛ files will be displayed to the Corporate User as shown in below Figure 1. To open the same, User will have to double click on the “.JAR” file.
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Figure 1

3) If J2SE version 1.6 update 29/30/31 or more is not installed on the machine, the User will not be able to open the ‘.JAR‛ file. The system will prompt the Corporate User to open the file with the help of an application.

4) After successful download and installation of FPU & FVU, Corporate will be able to use the same for the purpose of creation and validation of the SCF. For assistance in using the FPU & FVU, User can read the instructions provided in ‘Help Menu’ of the FPU & FVU.




 (
Summary


 
Corporates
 should be registered with CRA and have valid DSC base User IDs provided by CRA to access CRA system. 


 
Corporates
 should have required IT Infrastructure for preparing Subscriber Contribution File (SCF) and accessing CRA system. 


The File Preparation Utility (FPU) & The File Validation Utility (FVU) can be freely downloaded from CRA website www.npscra.nsdl.co.in. 


 
Corporates
 may use the FPU provided by CRA or its own back office software as per CRA file formats for preparation of SCF. In either case, the file generated should be 
run through the FVU. 


The machine on which the FPU and FVU are to be installed should have JAVA JDK & JRE version 1.6 update 29/30/31 or above. 
)









	
4. Processing of Contributions under NPS:
Various activities involved in Subscriber contributions processing are enumerated below:
      1) Receipt of Subscriber Contributions
      2) Preparation of Subscriber Contribution File (SCF)
      3) Validation of SCF using FVU
      4) Upload of SCF to CRA system

Figure 2: The activities mentioned above are explained in the following diagram:
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4.1. Upload of Corporate Contribution:

Corporate will get the contributions uploaded as per the file format provided for corporates for the subscribers who are registered under them. The same has been provided in the figures below along with the figures of the SCF preparation and validation.


4.2. Preparation of SCF using FPU:

The procedure for installation of FPU and FVU has been provided in Chapter No.4. Corporate should ensure that the latest version of FPU is being used for preparation of SCF. 

Corporate shall consolidate all the contributions details to be uploaded to CRA system. Corporate shall access the ‘FPU.JAR‛ file by (double clicking the icon) from the location where FPU is installed. Once Corporate access ‘.Jar‛ file, a screen will open as shown in Figure 3 below:


Figure 3 Corporate Contribution – FPU
[image: ]
The FPU shown above consists of two panels – 
· CHO & Contribution File Details Panel: In this panel, the User shall enter details such as Type of contribution file (original/correction[footnoteRef:1]), POP Reg. No as 5000682, POP name as eNPS & Transaction ID (in case of a correction file upload).  Please note that the POP Reg. No. should be mandatorily mentioned as ‘5000682’ i.e. the POP Reg. No of eNPS. [1:  The functionality to upload correction file in the CRA system is explained in the later ] 


· Subscriber Details panel: In this panel, the User shall enter the contribution details of the subscriber such as Subscriber PRAN, Subscriber Name, Employer’s Contribution, Subscriber’s Contribution  etc. and CBO registration number.

CHO & Contribution File Details Panel: 
This panel will open by default when the Corporate executes (or double clicks on the) ‘FPU.JAR’ file. Corporate User shall enter the following details, as shown in Figure 3 above.
1. Type of Contribution File (Original / Correction): Where Corporate is preparing a new (fresh) Subscriber Contribution file for uploading to CRA; User shall select the type file as ‘Original’. If User wants to make any correction in a SCF which has already been uploaded successfully to CRA and for which Transaction ID is generated by CRA, User shall select the type of file as ‘Correction’.
2. Transaction ID: As mentioned above, where file type is ‘Correction‛, the User shall have to provide the transaction ID of the original SCF for which the correction file is being prepared. If transaction ID is not provided, User will not be able to create the file. (The Transaction ID is the acknowledgement number provided by the CRA after successful upload of the SCF.)
3. POP Reg. No (5000682): User should enter the POP Reg. No as 5000682. allotted to eNPS in CRA system.
4. Name of POP (eNPS): This is an optional field. User can enter the name of POP i.e. eNPS in this field.
5. Contribution Details: i.e., the total CBO Count, Total Subscriber records, Control total (Employer), Control total (Subscriber) will appear automatically based on what User has entered in the ‘Subscriber Details‛ panel.
6. The fields which are marked with sign (*) are mandatory fields.



Subscriber Details Panel:
The view of the subscriber details panel of the FPU is shown in below Figure 4. Corporate User shall enter the Subscriber/employers contribution details in this panel for uploading the same to CRA system. 
Figure 4 -  Corporate Contribution – FPU
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User shall enter the following details:
1. CBO Reg. No.: User should enter the CBO Reg. No. (allotted by CRA) of the CBO with whom the subscribers are associated with .
2. PRAN: User should enter PRAN of the Subscriber for which contribution details are being entered.
3. Subscriber’s Name: User may enter Name of the subscriber. This is an optional field which can be used as reference to PRAN entered.
4. Employee Contribution: This field is for entering Subscribers Contribution details with respect to the percentage contribution made by subscriber.
5. Employer Contribution: This field is for entering employer’s contribution for the employee.
6. Pay Month: Pay month will be the contribution for the particular month for the subscriber.
7. Pay Year: Pay year will be the contribution for the particular year for the subscriber.
8. Contribution Year: Depending on the nature of the contribution, the following contribution types needs to be selected
· Regular
· Arrear
· Miscellaneous
· Unfreeze Tier I
· Unfreeze Tier II
9. Arrear Remarks: Depending on the type of arrear contribution, the relevant arrear remarks should be mandatorily selected.
10. Remarks: In case of arrear or miscellaneous contribution, the remarks need to be mandatorily provided.
11. Receipt Number: The receipt no.is not a mandatory field for upload of corporate contribution whereas the same is mandatory for subscriber’s voluntary contribution.

At the time of entering the data, FPU will perform format and structure level validations of the data which is entered by the Corporate User. In case where data entered is not as per the file format of CRA, FPU will display an error message to the user as shown in Figure 5 below:
[image: ]
Figure 5
Corporates can enter the subscriber details manually or copy the data from an excel sheet. To paste data from an excel sheet, Corporates can use ‘Paste from Excel‛ option. This can be done either by going to the Edit Menu and using the ‘Paste from excel‛ option or by right clicking the mouse in the cell in which the data needs to be captured. The contents will be displayed as shown Figure 6 below:
[image: ]
Figure 6
Corporate User can add or delete the required rows by selecting the Add Rows and Delete Row button provided at the bottom of the screen. The process of pasting the data is applicable for the different types of utilities
Preparation of Intermediate File:
1) In FPU, User will have the option to save the data at any point in a file while entering the details. This saved file will be an intermediate file. User can save the partially filled details by clicking the Save option in File menu as shown below Figure 7:
[image: ]Figure 7:

2) After clicking on the ‘Save’ option, the FPU will prompt the User to save the file on the machine. User can give file name containing maximum 8 characters. The details displayed will be as shown in Figure 8 below: 

[image: ]Figure 8
3) Once User selects the ‘Save’ option on the screen, a confirmation message will be displayed as shown in below Figure 9, which will also mention the path where the file is saved. [An Intermediate file will always be saved with an ‘.fpu’ extension. However, Corporate User cannot validate this intermediate file having ‘.fpu’ extension in FVU or upload to CRA system.]
[image: ]
Figure 9
4) The User can reopen the intermediate file for modifying the existing data or can use the same to prepare new contribution details. However, User should open the intermediate file with the same version of FPU. To open the intermediate file, User has to select the ‘Open‛ option in the File menu. 

5) For the purpose of record, it is advisable for the User to create a working directory containing the year-wise, month-wise, date-wise folders for SCFs prepared.

Creation of Subscriber Contribution File:
1) After complete digitisation of necessary details, the User can create the SCF by selecting ‘Create File’ button. Once the User selects the ‘Create File’ option, FPU will prompt the User to save the file on the machine as shown in Figure 10. User shall select required path and give desired file name having maximum 8 characters.
Figure 10
[image: ]
2) FPU will create an output file having extension .txt. FPU will also create a unique Batch ID to identify each file. This Batch ID will be displayed to the User in the final confirmation message shown after successful generation of the file as shown below Figure 11:
[image: ]
Figure 11
3. While creating a file, FPU will validate the following:
· FPU will check whether User has provided all the mandatory details and data type of all the fields is correct.
· FPU will check whether the CBO Reg. No., POP Reg. No (mentioned as 5000682) and PRAN are structurally correct.
· FPU will validate whether contribution amount is greater than zero
4. If the FPU encounters any error in the data entered by the User, such as, incorrect CHO registration number, null contribution amount, it will display an error message to the User. In all such cases, FPU will not generate any output file. The User will be required to rectify the errors and create a valid file again
Operating guidelines for preparing Subscriber Contribution File
1) Corporates shall enter the contribution details for the who are associated with them
2) It is mandatory to select the type of Contribution File as ‘Original’ for regular file and ‘Correction’ for correction file. By default it will be ‘Regular’. In case of ‘Correction’ file, Transaction ID is a mandatory field as shown in figure 12
[image: ]

Figure 12


3) User should provide all the mandatory details of the particular record in each line. FPU will display error message if any of the mandatory field is missing in any record entry.
4) Negative as well as zero values cannot be entered in the Subscriber contribution fields.
5) User shall not be allowed to validate with FVU, the intermediate files generated by FPU. Also intermediate files cannot be uploaded in CRA system.
6) User will be allowed to open the intermediate file only in the same version of FPU with which it was prepared.
7) User should not tamper the intermediate file as the tampered file cannot be opened using FPU. In such cases the FPU will display an appropriate error message to the User.
8) User cannot generate a blank Contribution File having no records. There must be at least one Subscriber record in a file and all mandatory fields should be entered.
9)  The User will have the option to enter the Subscriber name while preparing the file. This is provided only for operational convenience purpose of Corporates.
10)  Corporate User shall not be allowed to upload a FPU generated file having .txt extension to CRA before validating the same through FVU.
 (
Summary
Corporates
 shall prepare Subscriber Contribution File using CRA provided   FPU or its own back office as per file formats of CRA. In either case, the file generated should be run through the FVU. 
Corporates
 should use the latest version of FPU. 
The 
CHO
 Reg. No., and PRAN provided in the Contribution File should be active in CRA system. 
Corporates
 can prepare an Intermediate file using FPU which can be used for record purpose or carry out further modifications. 
)









4.3 Validation of SCF Using FVU:

After completing the preparation of the SCF using FPU or own back office, Corporate shall validate the output file with File Validation Utility (FVU) provided by CRA. It is mandatory for Corporates to validate the file using the FVU provided by CRA. Only the SCF which is successfully passed through FVU can be uploaded to CRA system. CRA system will reject the file if the same has not passed through latest version of FVU before upload to CRA.

To validate the SCF through FVU, the User shall double click on the FVU icon at the path where FVU is installed. Once the User clicks on the ’FVU.JAR’, the FVU will open as displayed in below Figure 13:
[image: ]Figure 13

Input File Name with Path
1) Corporate User shall specify the name (with the .txt extension) of the input file (including the path) i.e. the name of the SCF to be passed through FVU for validation.
2) The Input file name should not contain any special characters e.g:, “\” or  “/” etc and should not exceed 8 characters.
3) The file to be passed through FVU should be in ‘.txt‛ format only.
4) User can enter the path or he can select the same by clicking the ‘Browse’ button on the extreme right of the option ‘Input File Name with Path’.

Error/Upload & Control Sheet Report File Path
1) User will have to specify the path where either an ‘error file’ or ‘upload file’ along with the control total sheet is to be generated and saved by the FVU on successful completion of validation of the file. It is advisable to use the same path as the input file path. For error file or upload file, User shall only specify the path and should not specify any file name. FVU will provide the name for output file by default.
2) User can enter the path or can select the same by clicking the ‘Browse’ button on the extreme right of the ‘Error/Upload & Control Sheet Report File Path’.
3) It is mandatory for the User to fill both ‘Input File Name with Path’ and Error/Upload & Control Sheet Report File Path’. ‘Validate’ button will remain disabled till both fields are not entered properly.
4) After selecting the input and output folder, User should click the ‘Validate’ button to validate the Subscribers Contribution File. If the file is successfully validated, FVU will show a message as per below Figure 14 create the upload file with extension ‘.fvu’. FVU will also create a control sheet (an HTML report) in the path specified in the ‘Error/Upload File Path’ as shown below.

[image: ]Figure 14
5) While validating the SCF, FVU will perform the validations as mentioned below: 
· FVU will check whether input file is text file having ‘.txt’ extension. 
· FVU will check whether User has provided all the mandatory details. 
· FVU will check whether the CHO Reg. No., PRAN and receipt number are structurally correct. 
· FVU will check whether for each receipt number and PRAN combination, there is only one record within a file. In case of Duplicate record with the same receipt number and same PRAN in the file, FVU will reject the file. 
· FVU will check whether ‘Total Subscriber records’ are equal to the total contribution records for all the Subscribers. 
· FVU will check whether ‘Subscribers Control Total’ is equal to the sum of Subscribers contributions for all the subscribers. 
· FVU will validate whether contribution amount is greater than zero and is not negative. 

6) On successful validation, FVU will generate an output file with extension ‘.fvu‛ at location specified in the field ‘Error/Upload & Control Sheet Report File Path‛ Along with output file, FVU will also generate an ‘.html‛ file showing control totals (no. of Subscriber records, total contribution, etc.) as shown below in Figure 15: 
[image: ]
Figure 15


7) Subscriber contribution file (with ‘.fvu’ extension) is ready for upload in CRA after it has been successfully passed through FVU.
8) The procedure of validation remains the same for voluntary contribution.


 (
Summary
Corporate U
ser should validate the file using latest FVU provided by CRA. 
While validating, U
ser should provide the input file name and path along with   Error/Upload Control sheet report path. 
On successful validation of the file, FVU will generate an output file with extension “.
fvu
” along with a control total html file. 
)





5.4. Upload of SCF to eNPS System: 
4.4. Correction File:
CRA provides Corporate a facility to upload a correction file for any previously uploaded file which has been accepted by eNPS system and for which Transaction ID has been issued by CRA. However, User should take note of following points related to correction file:
· Corporate User can upload a correction file when User wants to make any changes in original file due to any incorrect data.
· User will have to prepare and upload the entire file even if a single record contains any error.
· The User should note that a correction file can be uploaded only for a file which is already uploaded and accepted by CRA.
· If a file is rejected by CRA, the User will have to upload a new file and not a correction file.
Further the user cannot upload a correction file if the original uploaded file is in Matched and Booked Status at CRA. User can upload the correction file only if the original file is either in ‘Accepted’ or ‘Match Failed’ status at eNPS.

4.5 Contribution File Upload in eNPS

After validating the SCF through FVU, Corporates shall upload the output file having ‘.fvu’ extension to CRA. Corporates shall upload the file using the DSC (Digital Signature Certificate) based User IDs allotted by the CRA. All SCF uploaded by Corporates till 17.30 hrs on day T will be considered for settlement process at CRA on T+1. During the settlement process, subscriber contribution amount will be invested as per the scheme preference applicable for the subscriber and the respective units will be credited to the subscribers account. 

Process of upload

1. Corporate User shall log-in to eNPS system (www.enps.nsdl.com) using its DSC based User IDs. On accessing the system, login page will be displayed to the User as shown below in Figure 16:

[image: ]
Figure 16

2. On this page, the User shall enter his User ID and select DSC certificate for login. 
[image: ]
Figure 17


3. On validation of User ID, a window to select digital certificate details will appear. Corporate User shall select the digital certificate mapped to the User ID used to login in the CRA system and click on ‘OK' (as shown in Figure 18). If the User ID provided by the User and the selected digital certificate is valid, home page will be displayed to the User. Corporate User shall select ‘File Upload‛ option from the menu as shown below in Figure 19 to upload the required SCF. 

[image: ]
Figure 18


[image: ]
Figure 19

4. On selection of the option ‘ File Upload‛, system will display a screen as shown below in Figure 20 to upload the files: 
[image: ]
Figure 20
(Note: If the appropriate configuration of internet explorer i.e. Version 6 and above and Java J2SE (version 1.6 update 29/30/31 )  is not installed on the machine, then in the event of selection of file subscriber contribution - upload option, no details will be displayed to the User on the screen.)

5. In the above screen, User shall select the ‘Browse’ option to add the SCFs to be uploaded. Once User selects ‘Browse’ button, a window will be displayed as shown below in Figure 21 to select the file to be uploaded. The User shall select the files to be uploaded (with ‘.fvu’ extension) and click on the click ‘Open‛ button to load the file. User can select multiple files with help of ‘Ctrl‛ key as shown below in Figure 21:
[image: ]
Figure 21

6. Once the file is successfully loaded, the User shall upload the file by clicking on the ’Upload File’ option. If upload of file is successful; eNPS will display the status of the file along with the unique BO File Reference Number and CRA File Reference Number to the User as shown below in Figure 22. User may note both the FRNs for record purpose. User can use these FRNs for viewing the status of the file in eNPS as well CRA at a later stage.

[image: ]Figure 22

7. After successful upload, CRA system will perform all the validations which FPU and FVU performs. In addition to the validations performed by FPU and FVU, CRA system will perform certain business and database level validations. CRA will check whether
· Duplicate files (having same batch ID) will be rejected at CRA
· CRA will not accept the file if it is prepared and validated through any older version of FPU and FVU. Files should be prepared and validated through latest version.
· FPU & FVU version, FVU hash and batch ID of the file are correct.
· File is tampered after generation.
· CHO Reg. No. and PRAN are valid and active in system
8. In order to view the status of the uploaded file, the User shall select the ‘Contribution File Status View‛ option, as shown in Figure 23. 
[image: ]
Figure 23

9. After selecting the ‘File Status View‛ option, a screen will be shown to User as per Figure 24 below, the User will have to enter any one of the following criteria’s:
· File Reference Number
· From Date & To date.
· Status

[image: ]
Figure 24


Once the User provides sufficient details, the status of the uploaded file will be shown to User as per Figure 25 below.

[image: ]
Figure 25


5. Transfer of funds through SBI ePay (Payment Gateway):
Once the file has been successfully uploaded and transaction ID is generated, the Corporate shall initiate the transfer of the funds for the respective transaction in the CRA system to the Trustee Bank through the SBI ePay payment gateway. 
1) The Corporate User shall click on the make payment option available on the Transaction Status page as shown in Figure 26:
[image: ]

Figure 26
2) On clicking the option of make payment the subscriber will be provided the details of the transactions for which the payment is being initiated as represented in Figure 27. 
[bookmark: _GoBack][image: ]
Figure 27

3) Please note that the Corporate User shall have the option to initiate payment against multiple transaction IDs in a consolidated manner by selecting the respective transactions as shown in Figure 26 below.

4) On confirmation the Corporate User is guided to the payment gateway portal i.e. SBI ePay for initiating the payment as shown in Figure 29.
[image: ]
Figure 29

5) Once the transaction is completed successfully the Corporate User will be provided with an acknowledgement as shown in Figure 30.
[image: ]
Figure 30

6. Tracking the status of contribution:
The Corporate User can check in the eNPS system whether trustee bank has uploaded the details to eNPS system for the receipt of contributions from Corporate. To check the details uploaded by bank, user will have to view the status of the uploaded file in eNPS system by entering the file reference number through ‘Corporate File Status View‛ as shown in figure 23 above and will press ‘Submit’ button. Once the user provides sufficient details, the status of the uploaded file will be shown to User. If the amount of SCF is matching with Fund receipt confirmation file (FRC) uploaded by bank, then the status of the file will be shown as ‛matched and booked‛. 
It may please be noted that in case files are not matched and booked within the stipulated timeline of T+15 day of upload of contribution file in the eNPS system, the said transaction is automatically deleted in the eNPS system. The Corporate will have to re-upload contribution file in the eNPS system.

----------------XXXXXXXXXXXX------------------
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